Frequently Asked Questions

Purchase, Download, and Installation

Updating WinSLAMM Data Files

Parameter Files

Pollutants

Representing Project Areas

Streets/Alleys

Volume/Flow

Calibration

Stormwater Control Practices

10. Stormwater Control Practices — Street/Alley Cleaning
11. Stormwater Control Practices in Series

12. Stormwater Control Practices — Infiltration Practices/Cisterns
13. Cost Data

14. WinSLAMM vs WinDETPOND

15. Model Input and Output

16. Model Errors

CoNOOA~WONE

Purchase, Download, and Installation
Need Password (July 2006)

Q. I just downloaded the zip file for a program update from the website and | need a password to extract
the files. Where do | get the password from?

A. If you purchased a new or renewal license within the past year, you should have received an email
regarding the program update with the password. If you purchased a new or renewal license more than a
year ago, you will need to purchase a new or renewal license. If you did not receive the password, but
believe you should have, please contact us.

Preview Software before Purchase (March 2007)

Q. Before buying this software | would appreciate seeing an example the input and output. Can you
provide examples of the WinSLAMM input / output for my review?

A.

e The website contains information and examples for WinSLAMM.

e Training opportunities are available. Refer to the Training Page on the website.
e Dr. Pitt's research website also contains many examples of model use, such as:
WInSLAMM and LID Pitt MD 2004.pdf

decision analysis Pitt and Voorhees James 2006.pdf



License Renewal Policy (December 2008)
Q. How do | know if | am eligible for a free version upgrade?

A. Review the License Renewal Policy posted on the website. Contact us if you do not have the date of
purchase.

Renewal License (January 2009)

Q. If I am operating on version 8.4 do | need a renewal or whole new license to be on the current
version?

A. The renewal refers to the time that has lapsed since the last purchase, not the physical program. If
the last purchase was between 1 and 3 years ago, then the fee is $150 plus the applicable handling and
taxes listed on the order form to renew the license. If the last purchase was more than 3 years ago, then
the fee is $300 plus the applicable handling and taxes.

When you purchase a new or update license, you will then receive a CD with the entire software package
(program, supporting files, documentation, etc).

Then, for the next year after the date of purchase, you will receive an email with instructions for
downloading upgrades that occur to the model for no cost.

International Costumers (December 2006)

Q. I am looking to purchase licenses of WinSLAMM and WIinDETPOND. | am located outside of the
USA. Is this an issue?

A. Attimes it can be difficult to send software outside of the USA. There are two options:

1. Send them via a shipping company such as Federal Express or the UPS. This option requires an
additional 25% payment due to the additional effort and cost for international shipping.

2. Put all the files into a password protected zip file on our website. You download them, and once they
are downloaded, we remove them from the website. With this option, the additional 25% for international
orders is not required.

Send the completed order form and check for the appropriate fees, along with the preferred option for
receipt of the software package.

Extension of Free Upgrade Period (March 2007)
Q. I am requesting a password for a free update of the latest version of WinSLAMM.

| purchased the program about 13 months ago and would appreciate a one time exception to the 1-year
policy because it is so close.

A. We appreciate efforts to keep business costs as low as possible. However, we have worked very hard
on the program over the years that it has been available, and believe we should be compensated for

that. Our pricing is also very low - in part so that small engineering shops can afford to use it - and given
the number of units that we sell, does not come close to covering the time we have spent on the

program. We therefore do not provide exceptions to the 1-year policy.



Invoices (April 2007)

Q. Will PV and Associates, LLC provide invoices? We would like to purchase a copy of WinSLAMM but
in order for our accounting department to issue a check | need an invoice, would you be able to email one
to me?

A. Yes, PV and Associates will provide invoices. Please fill out the order form, mail (or e-mail) it to us
with the request for an invoice, and we will send you an invoice. Once you receive the invoice, please
mail the check with a copy of the order form and we will mail you the software package.

Credit Cards (April 2007)
Q. Does PV and Associates, LLC accept credit cards?

A. No, PV and Associates does not accept credit cards at this time. We researched providing that option
for payment. We felt the cost to provide that option is more than we want to spend to obtain the option.

Purchase Orders (April 2007)
Q. Does PV and Associates, LLC accept purchase orders?

A. PV and Associates, LLC accepts purchase orders on a very limited basis. If your situation requires a
purchase order, please contact us.

Refund Policy (January 2007)
Q. What is PV and Associates, LLC refund policy?

A. PV and Associates, LLC will grant a refund of the cost of the software within 30 days of the date of
purchase if a purchaser of the software believes the software does not perform as documented. We have
always responded to (and welcomed) suitably documented error reports and have made every effort to
correct legitimate problems. However, we do expect the user to use the available help and documentation
tools for the program, as we cannot provide unlimited technical support or consulting. In all cases, our
liability is limited to the cost of the software license.

Documentation and Help File Location (November 2007)

Q. I recently received WinSLAMM CD and installed the program. | cannot locate the PDF files
mentioned in the letter. Besides the help screen, is there a tutorial, or at some written documentation that
could lead me through a computational process?

A. There are many forms of documentation available for the program.

On the CD there is a folder called "WinSLAMM\Documentation" that has the .pdfs of the

documentation.

e The Help File for the program is the most up to date documentation for the model. To access that,
just press 'F1' from anywhere in the program.

e User's Guides can be downloaded from the website for the most current version of the program.

e There are also many example .dat files that are installed with the program into the c"\program

files\winslamm folders.

e For training courses, refer to the website.



WinSLAMM Source Code (July 2007)

Q. | am working on some modifications to the EPA Storm Water Management Model (SWMM). As part of
this effort, | am very interested in reviewing the source code for SLAMM/WInSLAMM as well as SSIP. Is it
possible to obtain these and, if so, how can | go about such.

A. We don't typically distribute the source code for the model, as we have spent many years and many
hours developing it, with minimal outside funding. We do have extensive documentation for the model
available directly from our web site - www.winslamm.com.

Installing an Updated Version of the Program v10 and later (October 2012)
Q. I am installing the updated version of the program. How do | do this?

A. Using the "Remove Programs' function in the Control Panel, uninstall WinSLAMM v10. (WinSLAMM
v9 and earlier do not need to be uninstalled). Navigate to where the setup.exe file is located. Double-
click on the file. The installation wizard will walk you through the remainder of the installation process.

Installing an Updated Version of the Program v9 and earlier (September 2007)
| am installing the updated version of the program. | have the following questions:

Q1. Should I leave all other files in the c:\Program Files\WinSLAMM directory and subdirectories in place
and move ONLY the winslamm.exe and winslamm.hlp files?

Q2. Should | overwrite only winslamm.exe and winslamm.hlp with the newly extracted files of the same
name - again leaving all the original supporting files in the directory c:\Program Files\WinSLAMM
untouched?

Q3. Does it matter what version of WinSLAMM | am upgrading from?

Al. Yes, make a copy of only the files you are replacing and put them in a separate folder labeled by the
version number you are replacing. The files contained in the zip file are the executable (winslamm.exe),
the Help File (winslamm.hlp), and the log file (winslammlog.txt). PVA does not limit the number of
versions allowed on a User’s computer.

A2. Extract the zip file into your C:\program files\winslamm directory and it will only overwrite the three
files listed above.

A3. It does not matter what version is being updated. Check the USGS Wisconsin website for updated
parameter files.

Program is not Displaying Correctly (December 2013)

Q. I am a relatively new WinSLAMM user, and | am encountering issues with the way WinSLAMM itself is
displaying on my computer. In almost every window in WinSLAMM, it appears that the text is overlapping,
or cut off in certain areas, and on certain buttons. It appears as if all of the display windows are smashed,
and | am unable to resize them.

A. The first resolution to try is to adjust the monitor's screen resolution. Adjust the resolution until the
program is displaying correctly.



If that does not work, the second resolution to try if your computer has a Windows 7 Operating System:
1. On your desktop, right-mouse click and select “Personalize”
2. On the left hand side, down at the bottom, select “Display”
3. Select “Smaller — 100% (default)”

If that does not work, the third resolution to try is add an additional registry key to your computer.

The issue could be due to the type of font used in WinSLAMM. WinSLAMM uses a bitmapped font
instead of a true type font. A blog describing the issue can be found at:

http://blogs.msdn.com/b/developingfordynamicsgp/archive/2009/11/25/windows-7-bitmap-fonts-and-
microsoft-dynamics-gp.aspx?CommentPosted=true&Pagelndex=3#comments.

This is a solution proposed by the US Army Corps of Engineers. PV& Associates has not tested it, nor do
we support it. Discuss installing the registry key with your IT department prior to installing it. This solution
has worked for users that have had similar issues.

There is a link on the US Army Corps of Engineers website that prompts the user to download
“Win7_Font_Fix.reg” http://www.hec.usace.army.mil/software/hec-ras/known_issues.aspx This solution
will add a registry key that allows for the auto formatting of bitmap fonts on high resolution displays.

‘File Not Found’ or ‘Path Not Found’ Error (April 2008)

Q. linstalled WinSLAMM on a new computer. When | try to run the files, | get errors that it cannot find
the parameter files.

A. Most likely the existing WinSLAMM data files have the paths to the parameter files pointing to a
different location than they are currently stored. Verify the path listed in the WinSLAMM data file against
the parameter file locations. If they differ, modify the WinSLAMM data file or change the file

location. The default location for the parameter files is C\Program Files\WinSLAMM Files directory.

MSFLXGRD.OCX Error (December 2006)

Q. | am trying to open WIinSLAMM, and it says that | am missing the file MSFLXGRD.OCX. | currently
have the file MSHFLXGD.OCX. | am not able to the open the program, and this is the message it says:

“Run-time error ‘339" Component ‘MSFLXGRD.OCX’ or one of its dependencies not correctly registered:
a file is missing or invalid.”

Should | erase all of the WinSLAMM files and setup all of the files again?

A. Most likely WinSLAMM was not properly installed or the .ocx file has become corrupted. Uninstall the
program and then reinstall it. Contact us if this does not correct the problem.

Number of Computers Program can be Installed on (February 2007)

Q. How many computers can a single license be installed on?



A. The number of licenses an entity owns is not tied to the number of computers it is loaded on, but the
number of users. The program can be loaded on as many computers as needed in a single office
location. However, each office location should own the number of licenses for the number of users using
the program simultaneously. Additionally, licenses are not transferable between office locations.

Help File (December 2009)

Q. | cannot get the help file to work in the program

A. This problem typically occurs for those users who have the Windows Vista operating system. The
problem is that Microsoft did not include support for programs like WinSLAMM that use the Windows Help
(WinHIp32.exe) program in the Vista operating system. However, you can download the program from
Microsoft to fix this. For instructions on doing this, go to http://support.microsoft.com/kb/917607. This
page also has a link to the Windows Help program for Windows 7.

Updating WinSLAMM Model Files
Open v9 file in v10 (April 2013)
Q. | have projects files | created in v9.2. How do | open them in v10?

A. Atthis time, v 10 can only import v 9.4 files. To open a v 9.2 file in v10, first open and save itin v 9.4
(the Batch Editor can be used to update several files at once if needed). Then, in v 10, select "File", then
"Import DAT File". Navigate to where the file is stored and select "Open".

Most control practices will be imported along with the source area data. Some control practices will not
be imported due to the new program structure. These include land use control practices (used in v9 and
earlier) and grass swale data.

Automatic File Version Update - v9 and earlier (April 2008)

Q. When | open some of the standard land use files it tells me the file was created using WinSLAMM
version 9.0 and asks me if | want to go to the File Update window to upgrade the file to the current
version or cancel the file open operation. | am not sure what to select. After this, the .dat file update
information comes up and there are two tabs: Version 9.1 to version 9.2 and Version 9.0 to Version
9.1. Can you help me upgrade these files and if | should re-name them or not?

A. Depending upon how many you have, it could be tedious to rename each one. Instead, create two
folders in your project directory. Name the first “SLU Files v9_0" and the second “SLU Files v9_2". Puta
copy of the files in each. This way you will always have an original copy — the “SLU Files v9_0" files -
should you accidentally make a mistake. Then make sure you always open your file from the new version
directory - the “SLU Files v9_2" folder.

While you are in the Update tab, check the box next to “Do Not Show Rename File Option”. That will
suppress the message that pops up asking you to rename the file. As long as you're always taking the
files from the new version directory, you won'’t have to worry about renaming it.

Enter in the information for all tabs. Each tab adds the needed variables to upgrade them to the most
current version you are running. The Batch Processor has the ability to update a large group of files at
once.

Updating File Version in a Group using the Batch Editor - v9 (December 2008)



To update all the files as a group, go to Run/Run Batch Editor . . ., and select the 'Run a Set of .dat Files'
button. Select the directory where you have the files you want to process, and then add all listed files to
the run list. Select the '.DAT File Batch Changes' button, select the 'Process File List with Changes' radio
button in the lower left hand corner, and then select the "Process Files" button.

Parameter Files
Modeling a special rainfall amount or design storm. (December 2013)

Q. Just wondering if there is a way to model specific rainfall amounts, for example a 5.9" - 24 hour rain
event (100 year event) or even a 1.25" - 1 hour event (10 year event).

A. A single, specific event can be modeled. To do this, a small rainfall file must be created. Open an
existing rainfall file in a text editor (to use as a template for the required format of the rainfall file) and
delete all but number in the first row and the first two events. The rainfall file should now only have three
rows of data. Change the start and end times in the second row of the file to the rainfall

duration needed. The second row is the first event and this is the rainfall event desired to be

modeled. Set the rainfall event in the second row to have a start time approximately one or two weeks
later, and set the depth of the event to a very small depth, usually 0.01 inches. The purpose of the
second event is to make sure that any control devices, such as ponds, are allowed to drain out, and thus
the control practice results will be recorded appropriately. Finally, set the number in the first row of the file
to 2. This tells the model there are two rain events in the rainfall file. Save the new file with a different file
name,making sure it has the "ran" extension.

Reference Files versus Project Specific Files (January 2007)
Q. What files are created during a WinSLAMM model run and what files are used as reference files only?

A. The only files that will be created and changed per-project are the WinSLAMM Data Files (*.dat) and
whatever other detailed output files you select. The other files, i.e.: Pollutant Probability Distribution File,
Street Delivery File, etc.; are “reference only” files that will not change on a per-project basis. They may
be re-calibrated and thus change as new versions of the model are released, but they will not change
during a model run.

Supporting (or Parameter) File Location (January 2013)

Q. Is there a setting from within WinSLAMM that | can indicate/point to where the “default” data file will be
located so the end user doesn’t have to browse for it each time?

A. v9 and earlier versions does not provide this open. This option is available in v10. Set the default
files in "Tools" > "Program Options" > Default Current File Data.

Creating a Rainfall File (December 2008)

Q. How do you create a rainfall file that can be used in WinSLAMM?
A. Rainfall files are a text file in the following format:

First row: Total number of events

Second row and beyond: Rain Event Data



The Rain Event Data is as follows:

“Start Date”, “Start time (in military format)”, “End Date”, “End time (also in military format)”, “Total Rain
Depth (in inches)”

The following is an example of a rainfall file:
5

“05/01/88", “00:00", “05/01/88", “13:00", “2.5"
“06/01/88", “02:00", “06/01/88", “02:00", “3.0"
“07/01/88", “05:30", “07/01/88", “20:00", “3.5”
“08/01/88", “01:00", “08/01/88", “16:00", “4.0"
“09/01/88", “17:45", “09/01/88", “23:45", “4.5"

Enter the rainfall data in the above format. Save the file with a “.ran” extension. A rainfall file can also be
created automatically from Earthinfo CD-ROMS using the Rainfall File Utility Editor in WinSLAMM.

Rainfall Data Source (April 2009)

Q. What is the source for the rainfall data files in WinSLAMM? Does the data come from NOAA or a mix
of sources?

A. We use the NOAA data as published on the Earthinfo CD ROMs for almost all of the rain files
distributed with the program. We usually can get several decades of rainfall info for many sites in a state
with no apparent missing records. WinSLAMM has utilities that assist in importing and reformatting this
data, and in analyzing the rains to obtain typical patterns. For research sites, where we have our own
rainfall records from tipping bucket gages, we import that data. For some of the international sites (South
Africa and New Zealand, for example), the rain data are from the local climatic agencies.

Winter Season Date Range (August 2009)

Q. For clarification purposes, is it a correct alternative to checking off the box for Winter Date Range and
entering the dates to just set the start and stop dates to the winter range?

A, The two alternatives are not equivalent. The winter date exclusion option activates an increased load
in the street cleaning subroutine at the end of the winter season, while the option you've attached does
not. Our understanding is that the WDNR requires that a user in Wisconsin use the winter date range, so
the second alternative does not meet the WDNR requirement. The winter season option should actually
improve the performance of a street cleaner because there is, at the end of the winter season, a greater
street dirt loading on the street, which the cleaner can then remove. If the loading on the street is lower,
which would occur if the winter season option were not selected, then the removal rates are less.

Winter Season Date Range Continued (June 2007)



Q. We are experiencing a problem when we apply the winter range. For some reason when we apply
the recommended winter range (12/02 to 03/12), we see a reduction in total phosphorous as compared to
the same WinSLAMM model with no winter season range applied. This reduction, as expected, was from
663.9 to 637.4 Ibs. But, when we reduce the winter season range from to 12/02 to 02/12 we are
experiencing an increase in total phosphorous from the no winter range WinSLAMM model from 663.9 to
693.0 Ibs. Is this because the Wisconsin data that we used in our model is only calibrated to the specified
winter season range of 12/02 to 03/12?

A. When you check the winter season option, you are by default increasing the initial street load at the
start of every spring higher than if the winter season box is not checked. This was done by the DNR to
attempt to match the existing data more closely. Without the checked box, the initial loading is much
lower. It is low enough, in fact, to not provide enough mass to compensate for the additional events in the
model run, which is why you were seeing the results you found from the three model runs.

To see more detail in the model runs, go to Tools/Default Model Options and select the "Washoff or
Street Cleaning Detail File", which provides the details that go into the calculations for each event for
street dirt accumulation, washoff and cleaning.

Choosing the Appropriate Street Delivery File (November 2007)

Q. | am reviewing a stormwater model for a proposed development, and | am trying to determine which
WinSLAMM file for Street Delivery Parameter file would be most appropriate for the development — the
Residential and Other Urban file or the Commercial, Institutional, and Industrial file. Do you have any
guidelines on when to use each file, particularly when the development has mixed uses? The
development | am reviewing is a mixture of condominiums, indoor water parks, and outdoor recreation
spaces including some woodlands.

A. For a study area with several land uses, each street delivery file should be added for each land

use. Do not press the "Change all street delivery files to match the current file". Go through and tab each
street delivery file that corresponds to the land use files you have and then use the edit button to make
sure the path is clear.

Parameter Files (February 2007)

Q. Where do you get the pollutant probability distribution, runoff coefficient, particulate solids
concentration, and the particulate residue delivery files? How are they developed?

A. These are all supplied with the model, but are user accessible. They were developed after calibration
and verification mostly in WI and in AL, and found to work well in other areas. Dr. Pitt prepared a couple
of summary chapters for Bill James that summarizes our source area data, for example. The papers are:

Street dirt accum and washoff Pitt et al James 2004

Pollutant sources part 1 Pitt et al James 2004

Pollutant sources part 2 Pitt et al James 2004

Pollutnat sources appendix Pitt et al James 2004

Cannot Enter Rainfall Dates for Year 2000 and later (v 10.0.2 and earlier) ((November 2013)

Q. The rain file date in program options does not allow me to enter year 2005 as the rain file start date.



A. Any version prior to version 10.0.0 does not allow rainfall dates for year 2000 or later. To use the
rainfall data, subtract the years in the rainfall file by multiples of four (to account for leap year) so that all
the years are prior to 2000.

v10.0.0 through v10.0.2 have a bug where rainfall dates after 1999 cannot be entered into the Program
Options form. It can, however, be entered in the Current File Data form. Do not use the Program Options
form for entering rainfall dates.

If you would like to make that rain file the default file, after you have entered the rain file name in the
Current File Data form, select the button “Replace Default Values with these Current File Data
Values”. Do not go back to the Program Options menu, that will recreate the same error..

Pollutants

Roof Pollution Sources (July 2013)

Q. Are the roof loadings generally from dust particles in the air or possible shingle material, other roofing
material, etc.?

A. The particulates washing off from roofs are at a very low concentration generally and vary somewhat
for different areas. Atmospheric dustfall is one source (but so is vegetation debris from nearby trees). In
industrial areas, roof vents may also discharge materials. Overall, it is usually a small contribution
compared to other areas. Degradation of the roofing is also a potential source. That is most obvious for
zinc when any galvanized materials are used. There is much information on roof runoff and material
degradation in the literature.

SSC vs TSS in WinSLAMM (November 2007)

Q. Inthe new study, | will getting field measurements of total rainfall, total runoff, and total particulate
loading for up to three storms for one of the 5 areas to calibrate the model for that area and then use for
the other 4 area models. All the WinSLAMM literature I've reviewed talk about "particulates”. However,
I'm not sure in sampling terms what this means. Is it the equivalent of total suspended solids? As you
can see, | need to give my samplers guidance on what parameters to test for and | realize | have a
disconnect here. Is it appropriate then in discussing WinSLAMM results to equate particulates in
WInSLAMM with SSC from the lab?

A. We have always used SSC lab methods and not pipette TSS methods. We strongly recommend using
a USGS/Decaport cone splitter to processes the samples, and not shaking/pouring or pipetting. Sampling
of particulate-laden stormwater should be in areas of very well-mixed flows. One way is to sample where
the water cascades into a small container where the sampler inlet is. If using a typical inlet near the
bottom of a pipe, you may have stratification of particulates. Bed load sampling is also recommended, if
possible. In general, “particulate solids” in WinSLAMM does equate to SSC in the lab.

WinSLAMM Output — TSS (September 2007)

Q. I want to verify that we are reading the output of SLAMM correctly.
When we run a file:

The Particulate Solids Yield (Ibs) is 1,722 Ibs.

The Filterable Solids Yield is 7,629 Ibs.



The Total Solids Yield is 9,351 Ibs.
Which number represents the dissolved portion of the TSS?

A. Assuming you are using the WI_GEOO1.ppd pollutant probability distribution file developed by the
WDNR, the filterable number is also known as the dissolved number (or TDS - Total Dissolved
Solids). This represents anything that passes through a 0.45 micron filter.

In general, the Particulate Solids Yield represents Total Suspended Solids (TSS). However, check with
the local regulatory agency to determine the type of Solids that should be used to comply with regulatory
requirements.

Fecal Coliform or E. Coli (February 2007)
Q. Does the software include fecal coliform or E. coli. as pollutants that can be modeled?

A. Some of our included pollutant files contain fecal coliform data. If you have the source area data, you
can create your own (for E. coli., for example). See the following summary paper and thesis for some of
our recent research on urban bacteria:

Bacteria levels wet weather vs dry weather Suman and Pltt WEFTEC 2004
Student Thesis/Shergill Bacteria sources thesis
Modeling Pollutants not Available in WinSLAMM

Q. We are currently working on a rain harvesting project in Northern Jersey. We have been using your
WInSLAMM program to analyze various pollutant loadings. We would like to know if it would be possible
to add a few other pollutants to the program. We would like to analyze oil & grease & petroleum
hydrocarbons. Our clients are very interested in having these pollutants added to the analysis.

| would really appreciate if you could let me know if you are aware of any other models that could aid in
this analysis and work well with our results from the WinSLAMM analysis.

A. (Response from Dr. Pitt) The constituents in the pol file are dependent on the available data. If you
have regional PAH data from source areas, then it will be possible for you to create a pol file using that
data. You would also need to verify the results at the outfall also. Much of my source area PAH data for
the Birmingham area is included in an EPA research report posted at:

MCTT EPA Report
See page 39 on.

As far as | know, there are no other source area PAH data available covering most urban surfaces. We
are currently conducting research on PAH concentrations as a function of particle size for the Tuscaloosa,
AL, area, and we have some preliminary data now.

| also do not know of any data sources for oil and grease or petro hydrocarbons for urban source areas,
but outfall data is available. My National Stormwater Quality Database | prepared for the EPA includes
Phase 1 MS4 data from throughout the country. Version 1.1 is located here:

Research. Robert Pitt



NSQD EPA

There are only 165 petro hydrocarbon data points available (3.7 mg/L average value) nationwide. One
approach would be to search the database for the most relevant data for your area, and use the average
concentration with your predicted runoff volume data to obtain the mass discharges. We are about ready
to post version 3.1 of the database, but | don't know if we have any additional petro hydrocarbon data
available.

| am not aware of any other program that can predict these constituents, as the data is lacking.

It would be possible to create a pol file using our Bham data for PAHs, and check the predicted results
with the limited outfall data, and make some adjustments. We have done similar activities for other
folks. If you are interested in having us do this, let us know. The reliability of the results may not be high
due to the lack of site specific data, but this would be an indication. However, if you look at our early
1999 report, you will see that rain characteristics likely were more important than source areas for the
PAHSs (and presumably for the petro hydrocarbons also), in the absence of gross contamination from
industrial areas, so using the average outfall concentration and the predicted runoff volume (that
considers your rain harvesting controls) may be a reasonable (and more cost-effective) approach.

Representing Project Areas
Landscaped Areas (November 2010)
Q. What is the difference between Large Landscaped Areas and Small Landscaped Areas?

A. In terms of the algorithms the model uses to calculate runoff volume and pollution reduction, there is
no different. The different source area types are available to help the user track different areas in their
project.

Choosing a Soil Type (November 2006)

Q. Is there guidance in the WinSLAMM documentation to help users determine which soil type they
should check when completing the source area information?

A. When we set up the soil classifications clayey, silty and sandy, we assumed that they would
correspond to the SCS classification A, B, C, and D soils, with:

A - Sandy
B - Silty
C and D - Clayey.

Also note the recent soil survey paper Dr. Pitt wrote that will be posted on the PVA website (WinSLAMM
User's Guides | PV & Associates) to determine the disturbed urban soil characteristics.

A (WDNR). | agree with John's break-out and it mirrors what | have always done. Obviously, the problem
is that there are 4 hydrologic classes and only three soils in SLAMM however appendix A of TR-55
provides the following break-out which matches well with what John provided:

A - sand, loamy sand, or sandy loam



B - silt loam or loam

C - sandy clay loam

D - clay loam, silty clay, clay, etc.

Standard Land Use Files - v10 and later (December 2013)
Q. What happened to the Standard Land Use files in v10?

A. The Standand Land Use Files have been incorporated directly into v10. To access a standard land
use, add a land use to the white map space. Right-click on the land use icon. Select "Apply Standard
Land Use". A form will open where you will select the standand land use by double-clicking and then
entering the amount of each soil type for that standard land use.

Standard Land Use File Version from USGS Wisconsin Website - v9 and earlier (December 2008)

Q. Are the SLU .dat files for WinSLAMM Version 9.3.2? The most current ones from the USGS web site
are dated 3/3/2007.

A. The SLU files for download currently (as of January 14, 2009) from the USGS Wisconsin website are
in version 9.2. The program will automatically update the files to the most recent version when they are
loading into WinSLAMM.

Industrial Undeveloped Source Area (October 2012)

Q. I'm wondering about soil and contaminant transport assumptions and contributions
associated with the Industrial Undeveloped source. | recently received a model from an
engineer who used this source in his analysis and I’'m questioning the appropriateness of his
assigning an area as an Industrial Undeveloped source.

A. The program calculates the runoff volume from the Industrial Undeveloped Source Area using the
runoff coefficient for the soil type selected.

The particulate solids loading is calculated by multiplying that runoff volume times the Particulate Solids
Concentration coefficient for that source area.

If you review the Runoff Coefficient file and the Particulate Solids Concentration file in the Utilities -
Parameter File Editor, you can see the coefficients used. The Particulate Solids coeffiicient for the
Undeveloped Source area is by far the lowest concentration, therefore, this will result in a very low
pollution yield from that source area.

In general, the Undeveloped Source area is meant to represent the small undeveloped areas in an urban
landscaped - it should be touched very little by human activity - no mowing, no disturbance, etc. So, in an

industrial park, it would likely be an area that typically has tall vegetation, maybe some trees. It is not
meant to represent the land used for a BMP.

Representing pipes in a Watershed (v 10.0 and earlier) (November 2013)

Q. How do you model pipes or quantify results from subwatersheds within a watershed model?

A. Pipes will be added to WinSLAMM to allow this. Until then, the user should use the Other Control



Device. Set the Drainage Area Fraction to a very small number (generally 0.01) and the Water Volume
Reduction to a very small number (generally 0.01). This will result in a small amount of reduction,
however, the reduction should not be significant compared to the overall results of the model.

Creating a WinSLAMM Data File that represents a Large Basin - v9 and earlier (April 2008)

Q. I am modeling several detention basins. | have 'no control' models (using the batch editor) for each
detention basin’s drainage area. | would like to combine all the .dat files that make up a drainage area for
a detention basin and place a detention basin at the system outfall.

To my understanding, my problem is that the batch editor doesn’t appear to handle detention basin
controls, and SLAMM documentation states you cannot combine the same landuses with the "Combine
.DAT Files" editor and | have many of the same landuses per detention basin drainage area (i.e.
Residential = LDR, MDR, Mulit-family,etc.).

Could you please give me some advice on how to approach modeling a detention basin drainage area
with multiple landuse areas with the same land use type?

A. For your situation, you will most likely need to do manual combining and entering of the data.
You have two options at this time.

Option 1 is to determine if you can ignore any of the land uses in your basin. For example, is the majority
of the residential land use MDR with only a little bit of LDR and HDR? If so, you may be able to ignore
the LDR and HDR and just call all your residential MDR. You will need to use your judgment to determine
if this is an appropriate assumption. If you can do this for each land use, commercial, residential,
industrial, etc, then you can use the “combine files” function to create one .dat file for your basin.

Option 2 is entering the data manually into the model. If you cannot use Options 1, then you need to
create a spreadsheet of the source areas for each land use, add them up, and then manually enter them
into a *.dat file that specifically represents your basin.

Large Parks and WinSLAMM (August 2010)
Q. We are modeling large Parks with areas in excess of 100 acres.
For the large areas of land which is mowed grass, should this be modeled as “large landscape”.

What is the difference between mowed grass areas and areas which are actually landscaped with mulch,
plants, etc.?

A. Parks should be large landscaped areas in the model, although we have relatively little data for this
category. Most of our information is for smaller areas around homes. We have conducted infiltration tests
with and without sod for the same location and usually see differences, but the site to site variability is
large so it may not be reasonable to distinguish these areas. Compacted soils are much more critical. If it
is an athletic field, or some other area receiving large amounts of foot and equipment traffic, you should
use a soil texture one category down from the actual texture class (silty instead of sandy, for example).

Agricultural Land and WinSLAMM (April 2007)

Q. We have a large area of agricultural land draining to our site. How do you model agricultural land
using WinSLAMM?



A. Since WInSLAMM is an urban water quality model, it should not be used to model Agricultural land or
very large tracts of undeveloped/open space.

Directly Connected Areas vs Partially Connected Areas (November 2007)
Q. What are the definitions of directly connected and partially connected?

A. In general, a directly connected impervious area is an area that goes right to the storm sewer
collection system without passing over any pervious surfaces. Examples of this would be a rooftop where
the gutter outlets onto the driveway or is piped right into a manhole connected to the storm sewer

system. Another example would be a parking lot that drains to an inlet that is connected right to the storm
sewer system.

A partially connected source area is an area where the runoff flows over vegetation prior to entering a
storm sewer system. Examples of this would be a rooftop where the gutter outlets onto the lawn or a
sidewalk where the drainage is designed to runoff into the adjacent grass. For impervious area to be
considered partially connected, however, the runoff from it must flow over a specified distance that allows
the runoff to infiltrate. Typically 20 to 30 feet is a minimum distance used, however, you will need to
check with your regulatory agency for their requirements of the distance.

Modeling Airports (December 2007)

Q. I am currently trying to model the stormwater runoff for a regional airport. Is there a separate overall
category that airports would fit into (i.e. industrial) or a combination (industrial, commercial,

freeways)? Do you have any suggestions on how to categorize some of the sub-areas (taxiway, runway,
tarmac)? | realize SLAMM is based on more urban settings. But with the airport being many acres of
open space and large quantities of pavement (though not as heavily traveled as a roadway), I'm looking
for the most logical and appropriate way to model it. Are there any SLU files that are available for airports
(on the air side)? Are there any studies that have looked at the loading on airports?

A. There are currently not any WDNR approved SLU files for airports. The City of Madison does have a
.dat file it created for its airport that comes with the WinSLAMM program. Otherwise, users generally
make their own based on the source areas of the actual airport.

When choosing the land use for your airport, you will want to think of which type of land use you feel most
accurately represents it - i.e. commercial, institutional, industrial. Generally the residential or other urban
land use will not represent an airport. You can also check with the appropriate regulatory agency to get
their concurrence on the land use you choose.

As in all cases, the model would have to be calibrated and verified for a specific area. | have used
WinSLAMM for the Minn-St Paul airport to help design ponds in available areas on the airport. | was
focusing mainly on hydrology and hydraulics and that worked well using the industrial or commercial files.
That example is in the very large detention pond report (about 400 pgs) with the docs. In the early days of
the model (1970s), | also used the model for other large airports in the SF bay area. We had local
monitoring data (I monitored Oakland airport and the San Jose airport, but don't know where the data is
now, and would probably not be relevant to your location anyways; | know that JFK in NY was also
monitored as part of early 208 projects; we have not obtained any airport data for the NSQD though) and
if I recall correctly, the main difference for the runways and other aircraft paved surfaces is that the runoff
lacked the lead that was high for surrounding areas (apparently Pb was not in aviation fuel). The main
surfaces could reasonably be modeled using the roads and parking areas and large flat roofs (see the
airport example in the detention pond docs). Again, local monitoring would be preferable to calibrate the
model, especially for runoff quality. Being an airport, they at least may have site rainfall data! The
summary discussion in the detention pond docs probably also discussed FAA regs on standing water too
(if not, make sure you get those; another issue is the deicing use).



Streets/Alleys
Street Source Area Calculations (April 2008)

Q. We have two model runs. The first is before adding additional pavement and the second is after. The
additional pavement reduced the large landscaped area in the second one. The Ibs of TSS went
down. This does not seem reasonable.

We may be interpreting the "curb-miles" incorrectly. The street length does not change from pre to
post. We are adding an additional lane and DOT is adding two additional lanes. The street width
changes and reduces the large landscaped area (16.2 to 14.5 acres). If we add more pavement why is
the load decreasing?

A. WIinSLAMM uses two different routines to calculate the load for landscaped areas versus the load
from streets.

The load from landscaped area is calculated based on the area of the landscape and the soil type. In
many areas, runoff from landscaped areas have a much larger TSS concentration than runoff from paved
areas.

The load from the street is calculated based on its length in curb-miles and the street texture.

If the only source area you had in a dat file was landscaped area and you reduced the area of landscape
between pre and post, you would be reducing the load.

For streets, if the only source area you had in a dat file was street and you increase the area of the street,
but do not change the length of the curb-miles between pre and post you will not increase the load,
regardless of if the area increases. The increased area will result in a larger runoff volume for a street,
but not a larger TSS load.

Intuitively it does not make sense, because you would think that a wider street would create more load,
but based on the research, it does not. Street dirt accumulates along the curb; the central lanes are
relatively clean due to vehicle turbulence that blows that stuff to the edge, where it bangs up against an
edge (either parked cars or the curb). Most of our street dirt research reports included across-the-street
testing and confirmed this. See the San Jose 79 report on Dr. Pitt’'s web site for more information. It
creates more runoff volume because there is more impervious area, but not more TSS load.

Therefore, for you project site, based on the way it is modeled, you will see a reduction in TSS load. Your
runoff volume should increase however.

Entering Street Width (June 2008)

Q. | have a question about the Street Area input parameters to SLAMM, specifically the total street length
(curb-miles) and the estimated street width. Let's say there is a watershed that has only roadside ditches
(no curb) and only half of the roadway (from the centerline to the edge of pavement) flows to the device
being modeled. The total width of the roadway is 22', which makes half of the roadway 11'. Do | enter in
the total street width (22") or half of the street width (11')?

A. The street length and estimated width is independent on the type of roadside drainage system, so you
enter those values in all cases, with one exception.

The exception is if you have a divided road. For your example, assuming you are only modeling the
drainage area to the device, you enter the data for only half of the road.



If one side of the street is drained with a swale and other side is drained by a curb and gutter, then you
would enter the total swale length (considering that it is only on one side of the road) and the curb and
gutter for the other half. Basically, you want the drainage system to be divided 50/50 by swales and curb
and gutter. It doesn't matter to the model if the half of the streets drained by swales are separate streets
(the normal assumption) or only one side of the street.

How do you Model an Alley in WinSLAMM? (August 2007)

Q. Are the alleys counted as impervious area like driveways or are they included in the streets

area? For example, | compared a Medium Density Residential Standard Land Use file with and without
alleys. The one without alleys has a smaller street area and a large driveway area. The one with alleys
has a larger street area and no alleys. So, it appears as if alleys are considered streets in SLAMM.

A. If the alleys have gutters, then they could be modeled as streets. In the provided Standard Land Use
Files, the alleys are added into the Street Source Areas.

If the alleys just have pavement up to buildings or to grass (no curb and gutter) and have convex shapes
so water flows down the center, they would be modeled as Other Directly Connected Impervious Area.

Volume/Flow
Small Storm Hydrology and Pre-Development Runoff (January 2011)

Q. I have a question regarding your research of the Small Storm Hydrology Method and would be
extremely grateful for insight into its use.

As you are probably aware the SSHM method and your research has been referenced in the
Pennsylvania Best Management Practices Manual as way to estimate the volume of stormwater runoff. |
was able to read your paper "Module 3b: Small Storm Hydrology and Why it is Important for the Design of
Stormwater Control Practices." | began using this method in order to size my volume control BMPs with a
great deal of success. As stated on page 19 of your paper, it estimates a significantly lower volume than
the NRCS curve number method when utilizing the design storm of 3.2 inches.

My technique has been to perform a Pre Development analysis based on soil type to generate a volume
(assume the entire site is pervious in the Pre Development condition). The Post development analysis
would be inclusive of the same soil type for pervious areas and a higher Rv for impervious areas as
stated in the paper. The increase is managed through structural and non structural BMPs as required by
the PA BMP manual. There is no consideration placed upon the pervious cover condition (meadow, lawn,
etc.).

In your opinion and based on your research, is this proper application of the method? Am correct in
stating that the method sees no differentiation between meadow and lawn? If a requirement was to
analyze the pre development condition as meadow while the existing condition was lawn, woodland, crop
row, etc.the method would not see any distinction?

The standard size site that | work on is 1-60 acres.

A. Unfortunately, WinSLAMM is not an appropriate tool to estimate pre-development runoff, as the
hydrology components are only verified for urban conditions. The undeveloped option in the model is for
small outparcels that exist in many areas, and are not intended for agricultural or forested areas.
Hopefully you can use a regionally verified ag or forest runoff model for calculating those pre-
development values. The State of WI requested that we include a calculator in the model for pre-
development CN calculations, which we did. These are only for runoff volume and assume the traditional
constant CN values for all rains. The CN values can be obtained from TR-55 documentation. This may



only be appropriate for the larger rains, as TR-55 was developed for drainage design and not water
quality. | suspect that a 3.2 inch rain would be suitable. Since TR-55 has it roots as a ag model, that may
be acceptable. WinSLAMM does not do the full hydrograph generation as per TR-55, but does calculate
the runoff volume for each event in your rain file.

You access this option under the pull-down land use menu "pre-development areas and CN". WinSLAMM
requests areas and CN values and will calculate an area-weighted curve number for the area and will use
that to calculate the runoff volume for each event. Since we are not calculating TR-55 hydrographs for
routing, the normal limitation of compositing CN values that differ greatly does not apply when just
calculating runoff volume.

Modeling Traditional Design Storms in WinSLAMM (November 2007)

Q. | have a question about using WinSLAMM for generating pond discharge volumes and rates. It is my
understanding that WinSLAMM should not be used for calculating these values for the purpose of
comparison between pre-development and post-development rates for design storms (2-yr, 10-yr, and
100-ry).

A. WIinSLAMM is a continuous simulation model, and we typically do not look at design

storms. However, you can "trick” the model using design storm rainfall depths and durations, although

the hydrographs are not the typical SCS hydrographs. Also, regarding pre-development conditions, the
standard parameter files are not set up to account for very large undeveloped or agricultural conditions.

If you review the runoff coefficient file, which selects the runoff coefficient (Rv) that is used to calculate
the runoff volume, you will note that it uses rainfall depth and source area. Therefore, this is acceptable
for determining runoff volumes. However, the calculations for the control practice you are using may use
the time or intensity in the calculations.

An interesting note about design storms and WinSLAMMis that a researcher compared WinSLAMM with
other models - TR-55, SWMM, and the rational method, etc - using monitored storm data that included
larger storms. WinSLAMM actually did as good as or better than the other models in predicting the runoff
volumes from the storms.

Use caution when trying to do a pre- to post-development comparison using WinSLAMM. It would take a
lot of work to calibrate the model for that. Generally it is more appropriate to do the design storm pre- and
post-development comparison using hydraulic software.

Maximum Flow Limitation and Traditional Design Storms (September 2006)

Q. Is there a limit as to how much flow can be handled in the WinSLAMM program? For example, can a
100 year event be used on a small area such as 3 Acres?

A. There is no physical limit on the flow that the model can handle. As an example, we sometimes run a
series of design storms, including the maximum probable event (48 inches in Alabama) for much larger
catchments than 3 acres.

However, you have to be careful how you are using the modeled results. We have calibrated runoff
volume with WinSLAMM for mostly small to moderate storms, and probably have some 5 or 10 "year"
events included in the data set. However, flow rate calibrations are only available for rains of up to 1 or 2
year events. WinSLAMM was never intended to be a drainage design program, but can be used in
conjunction with other programs. As an example, | have used SWMM5 and HydroCad with WinSLAMM.
We will model a drainage area having stormwater controls and see how they will affect the design
parameters that can be used in the desigh models (such as the CN, which is very sensitive to rain depth,
development controls, and infiltration).



Complex Triangular Hydrograph (February 2007)

Q. How does the model develop instantaneous flow rates to be able to size BMPs? | did not see inputs
for hydraulic watershed information and read that “triangular hydrographs, parameterized by a statistical
approach, are used to simulate flow.” Can you please explain this?

A. The complex triangular hydrograph is similar to the double triangular hydrograph used by NRCS, etc.
We form it based on runoff quantity (calculated using my small storm hydrology for accurate predictions
for water quality events), runoff duration (a function of rain duration), and the peak to average flow rate
ratio (close to 3.8, can be modified by user). Dr. Pitt's website has several papers describing the small
storm hydrology issues and why it is preferred. See: Pitt Dissertation for further discussions, and a
summary paper at: Small storm hydrology Pitt james98. These do not discuss the current complex
triangular hydrograph, but do discuss the other flow parameters.

In-Stream Calculations (February 2007)

Q. Do you see this model as being able to provide information necessary to develop an implementation
plan for a fecal coliform total maximum daily load?

A. You will have to link the model to a receiving water model to calculate in-stream conditions. We have
several output options specifically designed to link with other models, with hopefully minimal data file
manipulation.

Initial Abstraction (March 2006)
Q. How does the model handle initial abstractions, particularly depression storage?
A. Initial abstractions on pavement are a function of pavement texture and slope, and confirmed by

plotting actual rain vs. runoff amounts (the plots are used to determine initial abstractions on pervious
areas also).

Calibration
Information for Calibrating WinSLAMM (February 2007)
Q. What information is needed to calibrate WinSLAMM?

A. Local rain information is the most important needs. We supply many rain files with the program;
others can be developed from Earthinfo CDs, for example. Descriptions of local development
characteristics are also important. This can be obtained from aerial photographs and ground surveys. We
have data for many typical land use areas. See:

WEFTECO5 impervious surfaces Bochis and Pitt for a summary paper describing this process and some
of our data.

Locally available monitoring data for well-described areas is needed to calibrate and verify any and all
stormwater quality models. The supplied files can be modified based on local data. The National
Stormwater Quality Database at: NSQD EPA contains much MS4 data from throughout the country (this
database is currently being expanded). You can probably obtain local data, if it is not in the database, for
some end of pipe calibration purposes.

WinSLAMM Calibration Process (September 2007)



Q. What considerations should be taken into account when calibrating WinSLAMM?

A. There are a number of considerations that we try to take into account when performing a
calibration. They include -

e Using only source area and outfall data to develop the parameter files since the model is not a
receiving water model. This allows us to take advantage of one of the main strengths of the model
- the source area approach.

e We start with the smallest, most uniform data that we have available, to start the parameter file
modifications, and then change the more complicated source area parameters using the more
complicated data sets and the new single source area parameters we just developed.

e |t's important to exclude ag lands, wetlands, woodlands and other undeveloped areas from the
calibration process as well as the model analysis.

Also note Dr. Pitt’s recent paper posted on the WinSLAMM web site
(http://www.winslamm.com/winslamm_guides.html) and included on the program distribution disk on
calibration.

WinSLAMM Calibration Considerations (February 2007)
Q. How do you calibrate WinSLAMM?

A. Calibration of WIinSLAMM is similar to calibration of any other stormwater quality model. The most
important need is having the necessary data. The rain files for running the program after calibration are
usually created from Earthinfo CDs (Golden CO); try to make as long of a file as possible, using several
rain gage stations near the area of interest, that have long records of data and almost complete coverage.
WInSLAMM can help you identify a typical shorter period for more rapid analyses, but Dr. Pitt tries to use
the 20 to 50 year record for my final analyses (the program is quite fast, so a run doesn’t take that much
time; if you have several pollutants and ponds, then it may take 10 minutes or so for a typical land use).
The docs describe the PSD files and if you do not have local data, you will need to select one of the
existing files (the NURP distribution seems most reasonable).

The calibration of a stormwater quality model requires a good data set: rain and runoff quantities, plus
pollutant concentrations (SS plus other pollutants of interest). Preferably, you would have at least a dozen
events monitored covering a wide range of rain depths and for several land uses representing those of
interest. It's easiest if no stormwater controls exist in the calibration set, at least initially.

e Start with the runoff file using the rain and runoff data. Create a rain file starting about a month
before the first rain and ending about a month after the last rain (in many cases, the monitored
events may not be contiguous, although that would be easiest). You can fill in missing rains
(approx) from the Earthinfo disk, if you don't have local measurements available.

o Describe the watershed as accurately as possible and create the dat files. Start with the simplest
land use (mostly directly connected impervious areas) and the standard runoff file and run the
program.

e Only look at the runoff results for events you have monitored, ignoring the others.

e Plot the observed vs. modeled runoff values. Hopefully, they have followed the 45 degree
diagonal line with little scatter. You will likely show a bias in the line though.

¢ Run your dat file with the source rain file, looking where the runoff is originating for different
classes of rains. Your plot may have a good fit for the smaller rains, but be too low for the larger
rains, for example. The source rain file will identify where the water is coming from, and which
coefficients may need adjusting.



o Make the necessary adjustments, keeping the parameters within reason. When you happy with
that dat file, move onto the next more complex site (having directly connected impervious areas
that you just adjusted, in addition to landscaped areas).

e Repeat the analyses, hopefully only needing to adjust the pervious areas.

e Finally, use a site that has paved areas draining to pervious areas and confirm the factors that
adjust for disconnected impervious areas.

¢ When you are satisfied with he runoff file (and only then), work with SS in a similar manner. The
street delivery file allows adjustments for the limited energy of some rains. You should probably
use the available files, as they were based on many source area observations. The delivery file
accounts for deposition of particulates in the drainage system, as source area values are always
larger than outfall values for smaller rains.

e When satisfied with the SS calibration, work with the pollutant file for the constituents of interest for
which you have the data.

Again, there is nothing unique about WinSLAMM requiring calibration; all stormwater quality models
require calibration. Without adequate data, you will have to use the parameter files that have been
created and tested elsewhere (the Wisconsin files most likely).

Calibrating WinSLAMM .PSC and .PPD Parameter Files (November 2007)

Q. I've been working with the .psc and .ppd files to compare stormwater pollution concentrations to NE
regional studies. One USGS study in the Charles has total concentrations of pollutants in mg/L, so I've
been converting the particulate concentrations (mg/kg) in the WI_GEOQOL1 files to mg/L using the
corresponding particulate solids file for easier comparison.

One question that has come up is that there is no representation of Paved Lane and Shoulder TSS (AT
13) in any .psc file for any land use other than Freeway. What particulate solids concentration does the
program use to calculate TSS loading from roadways in those other landuses?? Or does it use the AT 13
number for Freeway in Commercial, Residential, etc?

A. The ppd files have two parts: one for particulate bound pollutants, usually expressed as mg
pollutant/kg SS and the other for dissolved pollutants, usually expressed as mg/L. Some pollutants (such
as nitrates) are only present as dissolved pollutants, so they do not have a particulate counterpart. During
Dr. Pitts research, he analyzes the total forms and filterable forms, whenever possible, along with TSS
(using cone splitters and not pipette subsampling). The dissolved forms are straight forward, and we use
those values directly (along with the corresponding COV values to account for variability). For the
particulate forms, it is a bit more complicated, as you have outlined. Take the total form, subtract the
dissolved portion, and divide by the TSS (all for the same sample). With appropriate unit conversions, you
will obtain the particulate-bound concentration expressed as mg/kg. You can do this backwards, as you
are doing, as long as you use the correct and corresponding values. You will need to add the filterable
concentration to the particulate concentration to obtain the total concentration that you are measuring.

Stormwater Control Practices
Pipes used for Water Quality Storage (June 2012)

Q. | am using the wet detention pond to model the large diameter pipe that will be used for underground
water quality storage. WinSLAMM does not allow the areas in the stage-area data to get smaller as the
row number increases. How do | model these types of systems?

A. One option is to convert the cross sectional area into the equivalent square pipe size and check that
there is at least three feet of dead storage below the outlet invert elevation. Also check that the pipe does
not surcharge with an appropriate emergency overflow. It is important to check with your regulatory
authority to make sure this approach is acceptable. See the attached graphic.



Grass Swale Infiltration Rate (November 2009)
Q. What infiltration rate do | use to model a grass swale?

A. The infiltration rate used in the grass swale algorythm is the dynamic infiltration rate. Many resources
and field measurements report the static infiltration rate. The dynamic infiltration rate is the static
infiltration rate divided by two.

Control Practice Geographic Location (February 2007)
Q. How does the model account for where the BMP is geographically placed within the source area?

A. Stormwater controls can be associated with development characteristics (such as disconnecting
impervious areas), source area controls (such as rain gardens, parking lot bioretention/biofiltration
devices, upland wet detention ponds), drainage system and public works controls (street cleaning,
catchbasin cleaning, hydrodynamic devices, grass swales), and end of pipe controls (wet ponds, large
infiltration areas), etc. They are associated with specific source areas within each land use (several
different roof categories, for example), for several source areas combined, etc.

Dry Detention Ponds (June 2008)

Q. How do you model dry ponds in WinSLAMM? After speaking with a few people at the WDNR, they
were saying with the version 9.3 you can model them as wet ponds with a very small wet pool (like an
inch) and get some credit for them. | have tried doing this and only came up with a 0.5% TSS reduction.
Which | guess is some credit, but | would think it should be around 10%-15% (Similar to what | receive
modeling swales)

A. The model currently calculates a reduced level of performance associated with dry ponds compared to
wet ponds, due to scour. The dry pond literature is very confusing and conflicting; the wet pond literature
is much more consistent. It takes a great deal of data to understand what is going on in a device having
limited removals. Many of the available docs are limited in the number of samples obtained and the
results vary greatly. In research that included much data, the long-term performance of dry ponds can
approach zero. Also, there is a large variation in how dry ponds are defined.

The basic theory behind grass swales is different than the theory behind detention ponds in SLAMM. For
grass swales, the runoff is being routed through a long area and thus the particles have more of an
opportunity to be filtered out by the grass. Wet detention ponds are based on the settling of the particles
in water. Therefore, the larger the surface area of the permanent pool, the more particles can settle out.
The main difference between dry ponds and grass filters is the concentrated flows and flow depths
present. Our plan is to eventually enhance the calculations for dry ponds based on recent grass filter
research and on current scour research. During very low flows with a level spreader, high levels of
particulate trapping will likely occur, as the water gets to be about 4 or 5 times the vegetation height, little
trapping will occur. Scour will also occur in areas of concentrated flow, and if the water depth is shallow.
When the water depth is about 3 ft, scour is minimized.

Another option for you to try is modeling the dry pond as an infiltration basin. The only reduction will be
from the amount of runoff that is infiltrated into the native soil.

Modeling Complex Outlet Structures in WinSLAMM (September 2007)

Q. How do you model a multi-stage outlet structure? | have a structure that first allows flow into a small
orifice that flows to the outlet culvert. When the water level is high enough it overflows into a 2-foot
diameter vertical standpipe. However, that 2-foot diameter flows to a smaller outlet culvert (the same one



the first small orifice drains to). If all three are entered, does the program assume direct outflow from
each one?

A. First, a quick review: The model is analyzing the water quality storm events, not the larger design
storm events. The largest event in any of the rainfall files provided for Wisconsin is a 2-year storm, the
rest are smaller. So, when you're modeling your ponds for water quality, it's very helpful to think of how
you want your outlet structure to perform for the 2-year storm event or below. To see how your pond will
function in the larger storm events, once you have your water quality outlet designed, you will want to
analyze in a water quantity software package.

With that being said, the next thing to think about is what will be your limiting factor for your water quality
storms (less than the 2-year event)? Is it the final pipe the orifice and vertical standpipe drain to, or is it
the orifice itself. Generally it is the orifice that designed for the water quality storms (I'm not sure how
you've designed yours, so I'm just guessing here).

Use the "Water Balance Summary of All Detention Ponds" detailed output to see how your pond is
performing for each event. It will show you how high the water gets in your pond and which outlet
structures it goes through. The file has "PWB" in the file name - it will be a .csv file.

Run your model and review the detailed output. Check to see if any of the events reach your vertical
standpipe. If they do not, then you know your orifice is the limiting factor and you do not need to worry
about the final pipe the orifice and vertical standpipe drain to. If your output tells you a lot of the water
goes through your vertical standpipe, then your final outlet pipe may be the limiting factor. So, in that
case, remove the orifice and the vertical standpipe and just enter the final pipe.

For your outlet structure, do not enter all three at once because the model will use all three structures at
once to estimate the outflow of the pond. This will overestimate the capacity of the outlet structure and
thus result in a smaller TSS reduction. This does not sound like the correct way to model your outlet
structure (without seeing a copy of the plans).

Another option is to use another program to calculate a stage-discharge curve for the entire outlet
structure and then enter that information in as an 'Other Outflow' outlet.

Catch Basin Calculations (January 2008)

Q. Due to scour, some material is lost from the sump during larger runoff events and | believe that
regular cleanouts should result in greater material capture. I'm not sure how much more credit would be
gained but currently SLAMM doesn't give any benefit for regular cleanout (except to restore sediment
storage area if it gets filled). Have you given any thought to factoring in credit for regular cleanout or
mandating cleanout more often than to just restore sediment storage area?

A. We currently account for scour by assuming that the devices cannot fill up to anything more than one
foot below the device. If the devices reach this level, then they can store no more sediment. This has, so
far at least, proven to be a reasonable assumption based upon the scour modeling and monitoring that
Dr. Pitt has been doing. If we assume that we are modeling inlets, where the water flows down from
above, and not manholes with sumps, where water flows can enter in from the sides, it seems that it
takes an extra-ordinary flow to affect the sediment below a foot or so.

In the model, cleanout benefits occur when the catchbasin density decreases, as this will fill them up
faster.

Modeling a Constructed Wetland



Q. How would you model a constructed wetland using WinSLAMM?

A. In WinSLAMM, you can model a wetland as a wet detention pond for physical settling behavior
predictions. The performance will likely be much less than a typical wet pond due to the shallow water,
and expected scour. Sedimentation of particulate-bound P would be predicted, but not reductions in
soluble forms. You could also use a specialized wetland model or a water chemistry model to predict
soluble P reductions and then adjust the WinSLAMM outputs.

Model All or Part of a Project Area (August 2009)

Q. We've got a 4 acre site draining to a wet detention pond. Half is existing built-out conditions, half is
new construction. The new construction requires 80% TSS removal. We have our wet pond modeled as
an Outfall->Wet Detention.

My question is, can we only input the new construction source areas when calculating the TSS removal,
or must all 4 acres be included in the model? I'm guessing that running the model with only half of the
actual flow through the pond will not give us an accurate design.

A. Correct, all of the drainage area needs to be modeled when evaluating pond performance. Pond
performance is highly dependent on the amount of water flowing to the pond and to the pond "size." Only
having half of the water enter the pond would result in a significant over-prediction of performance.
Another approach is to determine how much TSS comes from each side of the development and use the
ratio of the TSS amount from the new area to the total TSS amount from both areas to adjust the 80%
target. If 25% of the total TSS came from the existing area and 75% came from the new area, the the
pond performance target would be about 7% of 80%, or about 60% TSS reduction. Obviously, you would
need to have the approval of the reviewers for any approach you take.

Stormwater Control Practices — Street/Alley Cleaning
Street Cleaning Calculations — Frequency (February 2008)

Q. | have a general street sweeping question. 1 am working with a municipality to look at the cost
effectiveness of implementing some BMP’s to get to their 40% removal goal. We did the SLAMM
modeling for them and | was running their models playing with the street sweeping control device. | found
that there was a convex portion of a graph comparing removal vs street sweeping frequency. | included a
table below to illustrate.

No

Residential Street Sweeping Controls With Controls Difference

Percent Reduction TSS (Ibs) TSS (Ibs) Removal
Once a Year (Current) 4376668 3554000 18.80%
Twice a Year 4376668 3552000 18.84%
Every 12 Weeks 4376668 3577000 18.27%
Every 8 Weeks 4376668 3570000 18.43%
Every 4 Weeks 4376668 3555000 18.77%
Every 2 Weeks 4376668 3518000 19.62%
Every Week 4376668 3481000 20.46%
Twice a Week 4376668 3442000 21.36%
Three Times a Week 4376668 3418000 21.90%
Four Times a Week 4376668 3408000 22.13%
Five Times a Week 4376668 3401000 22.29%
Everyday 4376668 3392000 22.50%




Why does the removal temporarily decrease with frequency?

A. The street cleaning routine works by cleaning the streets on the specified frequency you give it. If it
rains on the day it's supposed to sweep, the program skips that cleaning (because public works
departments don’t generally sweep when it rains). Otherwise, it just continues to clean on the days that
fall on the specified frequency.

What is happening is that the program is skipping a cleaning due to rain, and thus the sediment

removal is reduced. You can compare the “Washoff or Street Cleaning Detail File” for each frequency to
see when the model is cleaning. To initialize this file, you check the box in the “Detailed Output Options”
form.

Longer periods of simulation reduce these small affects associated with rain occurring on days of street
cleaning. The five year period recommended by WI DNR normally reduces these effects to small values.
However, if smaller inconsistencies are desired, then expand the study period.

Street Cleaning Standard Land Use Files with Alleys (August 2007)
Q. If you have street sweeping on a SLU file with alleys, do the alleys get swept?

A. Because alleys are added to the street source area in Standard Land Use files, the alleys will be
swept if street cleaning is applied to the street source areas. The user needs to check that this is
appropriate (refer to Street Cleaning and Alleys FAQ).

Street Cleaning and Alleys (August 2007)
Q. Can you model street cleaning an alley?

A. Street cleaning data only shows effective reductions for street cleaning surfaces with a curb. The
street cleaners need to brush against a vertical edge. Therefore, if the alley does not have a curb, street
cleaning in the alleys should not be modeled.

Street Cleaning Removals — Spring Load (June 2008)

Q. When looking at street sweeping removal efficiencies compared to sweeping frequency, there seems
to be a reasonable correlation. Sweeping every 12 weeks gave a 1.63% removal, and 7 times a week
gave a 26% removal, with reasonable rates in between. However, the Once per year (spring) and twice
per year (spring/fall) seem to have unusually high rates (11-12%) compared to the other frequencies. Are
these two frequencies calculated a different way?

| understand that if a scheduled sweeping event coincides with a rainfall event in the rain file, the
sweeping event is cancelled. In the Green Bay rain file, there are rainfall events on both 4/1 and 10/31,
so theoretically the spring/fall scenario would be cancelled, but it still has an 11% removal

efficiency. Switching to the 5-year rain file helped out some of the lower-frequency sweepings, but did not
change the results of the spring or spring/fall scenarios.

Is there a logical explanation as to why the spring and spring/fall scenarios don’t seem to follow the
typical trend?

A. Research data shows there is a large winter load. This winter load is a result of the normal dirt and
also the winter sanding practices. This dirt is not washed off because it doesn't rain in the winter
(typically). So, the curve starts out really high in the beginning of spring, falls quickly due to rain events
and then does a saw tooth pattern through the summer and fall until it snows again. When you street



clean, the street cleaner is taking out some of the dirt along the curve at various times during the

year. So, when you sweep twice a year, the model takes some dirt from the high part of the curve in the
spring and then some from the end of the curve in the fall. When you sweep every 8 or 12 weeks, a
majority of the high part of the curve has already been washed off due to rain events, thus the sweeper
cleans a less high part of the curve and cannot achieve as much reduction. You can see exactly when
the sweeper cleans in the detailed output files that are accessed through the "Tools > Default Model
Options" screen.

Street Cleaning Removals — Not Using the Winter Season Option

Q. It doesn’t seem that my street cleaning control is doing anything in that the “washoff or street
cleaning” file (attached w/ .dat) doesn’t show any difference between initial and after event loads for street
cleaning. It does however, for washoff.

A. The reason why it doesn't show any difference is because the before event load is always lower than
the MinStDirtRemovalLoad, which is the lowest street dirt load that the street cleaner you have configured
can clean to. If you were to run the model with the winter season option, that increases the initial load
significantly, which should be, at least initially, higher than the minimum street dirt removal level.

Modeling Parking Lot Sweeping (January 2009)

Q. I was wondering if I'm able to use the street cleaning option for paved parking areas and

driveways? Our client regularly runs a street sweeper through their parking lot, but I'm unable to input
anything for street cleaning for paved parking and driveways w/in the program. | get a message that says
"Street Cleaning is not available for this source area". Do you know a way around this? Should | just
model the parking lot as a street?

A. There is little data regarding the performance of street cleaning in parking lots, so sweeping parking
lots it is not included in the model at this time.

Stormwater Control Practices in Series
Modeling Control Practices in Series — Sedimentation only Practices (October 2007)
Q. Can I model practices in series using WinSLAMM?

A. Control Practices in series can be modeled in v10 or later versions. The model will route both the
particle size distribution and hydrograph through each stormwater control practice. In v9 and earlier
versions, very few control practices can be modeled in series. Refer to the documented posted on the
Select Documentation page of this website.

Modeling Control Practices in Series — Street Cleaning and Catch Basins - v9 and earlier (June
2008)

Q. I'm trying to get a better understanding of why street cleaning and catchbasin controls cannot be
modeled together. The help file says:

"The particulates removed by street sweeping and the particulates removed by catchbasin are typically
composed of similar large particle sizes. To prevent an inaccurate increase in the reduction in sediment
removal because of this, the model will not route the remaining sediment from those streets that are
swept to the catchbasin if both practices are modeled together."



Could someone please elaborate? Why would a fraction of the larger particulate not be removed from
street sweeping, then the remainder routed to the catchbasin where a fraction of the remaining larger
particulate may settle out?

Many of the candidate sites I'm studying for LID retrofits have these two controls on-the-ground. Is there a
workaround to recreate these existing conditions?

A. Currently, the help file is accurate and describes the problem of double-counting the same material
that may be credited by the two controls. WinSLAMM currently reduces the load via street cleaning by a
straight percent reduction based on current research data, it does not modify the particle size
distribution. The routing version of WinSLAMM that is currently being developed will specifically route
particle size distributions and will be able to address this issue specifically. Our outfall monitoring data
shows no significant benefit of using these two controls simultaneously. This is briefly summarized in the
following class module wrote in 2007 that emphasizes an overall mass balance monitoring approach and
sediment transport issues:

Module 4b2
Modeling Control Practices in Series — Rain Gardens and Catch Basins - v9 and earlier

Q: I am modeling 5 rain gardens and 1 catch basin for a residential urban area. The rain gardens and
catch basin are parallel entities but | want the overflow from the rain gardens to go to the catch
basin. Can | do that in WinSLAMM?

A: Yes, WinSLAMM can perform this type of analysis. You will enter your rain gardens as Land Use
Biofiltration. You will enter the data for one rain garden and then put a "5" in the "Number of Devices in
the Source Area or Land Use" cell. You then enter the catch basins as a Drainage Control. The runoff
resulting from the rain gardens will then be routed to the catch basin. Note that you should not use the
particulate reduction option in the biofilters, as you would be double-counting the reduction of the
particulates removed by the catchbasin.

Modeling Control Practices in Series — Street Cleaning and Wet Detention Ponds - v9 and earlier
(December 2008)

Q. What is the correct way to model watersheds that contain street sweeping that lead to a wet pond so
pollutant removal is not double-counted?

A. At this time, WinSLAMM does not modify the particle size distribution resulting from street

cleaning. Therefore, when modeling Street Cleaning followed by a Wet Detention Pond, the model will
see the same size particles (but less of them) that it saw for Street Cleaning. Because street cleaning
and wet detention ponds will remove the same large size particles (and the pond also removing more of
the smaller particles normally), judgment needs to be used when modeling street cleaning and wet
detention ponds.

If data is available regarding the resulting particle size distribution from street cleaning, the user can
create a project specific particle size distribution to enter into the model.

Refer to the local regulatory agency to determine what is acceptable for the project area.
Stormwater Control Practices — Infiltration Practices/Cisterns

How do | model a Green Roof in v10.0? (November 2013)



Q. How do I model a Green Roof in v10.0?

A. A Green Roof is modeled using the Biofiltration Control Device. The native soil infiltration rate will be
set to zero (because traditionally the designer does not want runoff to infiltation into the actual roof of the
building). The total depth will be the depth of any rock, engineered soil and then a small amount for the
default broadcrested weir (all Biofiltration Control devices require a Broad Crested weir as an outlet). The
outlets will be an underdrain, evapotranspiration, and the before mentioned broad crested weir. Plant
types must be entered for evapotranspiration to occur. If actual evapotranspiration rates are not known, a
reference is posted on the Select Documentation page of the website.

Can't Access "Other Outlet" in Biofiltration Control Device (v 10.0.2 and earlier) (December 2013)

Q. | see the Other Outlet in the Biofiltration Control Device, but the program won't let me input data into
it. How do | use it?

A. In versions 10.0.2 and earlier, the Other Outlet is not available. The information in the form is a
placeholder for future versions.

Using Regulatory Agency Provided TSS Reductions in Biofilters (December 2012)

Q. I am doing a project in a location where the regulatory agency allows 80% TSS reduction for runoff
that flows through an appropriately sized biofilter. I've entered the characteristrics required (soil depth,
rock fill, etc) and I'm only getting 60% reduction. How do | modify my model file to account for the
reduction allowed?

A. The program will allow users to enter a percent reduction instead of calculating it using the research
data integrated into the model. To activate this open, in the Media Data form, select the User Defined
Soil Type. Close out of the form. Then, in the “Percent Solids Reduction due to Engineered Media (O-
100)” enter the allowable percent reduction.

Biofilter Removal Efficiencies - v9 and earlier (December 2008)

Q. | have a question in regards to the biofiltration portion of the WinSLAMM model. I've plugged in all the
information in regards to my biofiltration area and it has a spot where it automatically calculates "Percent
solids reduction due to engineered soil". For our engineered soil, we were going to use a loamy soil and
so the program plugs in 49 for the % reduction. If | change the size of the biofiltration device or the depth
of the engineered soil, it doesn't change this number. The only thing that changes it is the soil type
selection, but nothing goes past the 49. Just for the heck of it, | ran through the calculation module and it
says that | have 93.98% reduction, even though it still shows 49% in the biofiltration area. Can you shed
some light on what is happening?

A. The percentage reduction values were summarized from Dr. Pitt's research. Currently, the soil
treatment examines several particle size ranges separately. The effluent quality for each size range is
dependent on the influent concentration for each soil/media type (and considering an “irreducible”
concentration). The earlier version of the soil treatment for biofilters assumed a constant percentage
reduction, as an interim method before the more recent change to the model. The reductions are
calculated based on the soil type you choose and the particle size distribution you enter. The calculations
also assume that the engineered soil is 18 inches or deeper..This reduction is only applied to water that
passes through the engineered soil and is then collected in an underdrain and discharged to the surface
waters. It does not affect surface waters bypassing the bioretention device (receives zero treatment) or
water that infiltrates into the native soil (receives 100% treatment), for example.



By making the biofilter bigger or deeper, you are adding more storage volume, which aids in the TSS
reduction because the more water you store, the greater the chance the water can be treated or infiltrated
instead of being bypassed.

My guess is that your biofilter is also infiltrating water into the native soil. This infiltration provides 100%
treatment of the runoff that is infiltrated into the native soil. So when the program calculates the reduction
from the water being infiltrated and the water being treated by the engineered soil, it adds up to 94% in
your case.

Biofilter Ponding Durations

Q: Can SLAMM be used to predict the time it would take the water to stay in the rain garden before it
infiltrates or evaporates, etc?

A: WinSLAMM reports numerous data regarding the performance of a biofilter, including the ponding
durations. To obtain this data, go into the "Detailed Output Options" form under the "Tools" menu and
check the box for the "Water Balance File" under the "Biofilters”. Then select "Save .INI file". Once you
run the model, the program will create a separate comma separated value file in the directory you have
the .dat file saved. You can open this file in Microsoft Excel and review the data. Each column in the
comma separated value file is defined in the Help File that comes with the program.

The ponding durations reflect the total time water is in the biofilter, including during the rain event
itself. To find the net ponding durations (which are generally required for reporting for some regulatory
agencies), subtract the rainfall duration from the ponding duration for each event.

Rain Barrel/Cistern Storage Duration (June 2007)

Q. We are using rain barrels as a BMP for roof runoff. When we use the biofiltration input screen and
click on rain barrels/cisterns the load reduction results are not sensitive to the number of rain barrels
used. The results do not change when we add more rain barrels.

A. Review the bioifilter water balance file to see if the results you are seeing make sense. You are
probably not filling up the rain cistern during the model run. Therefore, additional ones wouldn't matter.

To look at the water balance file, go to Tool/Default Model Options and check the biofilter water balance
file option.

Porous Pavement on Street Areas (December 2012)

Q. I'would like to model the streets with porous pavement. Porous pavement isn't an option as a Street
Source Area Control Practice.

A. Currently, porous pavement is not available as a street source area control practice because data
does not exist that would allow us to integrate the porous pavement performance with the street dirt
algorithms. Therefore, at this time, the only option is to set up a parking area as porous pavement.

It is expected that porous pavement will be available as a drainage system control practice. in version
10.1.0. This is then allow the user to model the effectiveness of porous pavement serving a street source
area.

Modeling Biofilters in version 9.2 or Prior (December 2007)

Q. I am modeling a biofilter in version 9.2. My results do not seem reasonable.



A. In WinSLAMM versions prior to 9.3.0, there are two options in modeling biofilters. In versions prior to
version 9.3.0, the flow rate through the engineered soil is not included in the biofilter

calculations. Therefore, if there is an underdrain, the capacity of the underdrain is the limiting factor. This
can cause a biofilter to be undersized if the user does not do the necessary checks.

The first check is to model the biofilter exactly as designed (the pea gravel layer, underdrain, engineered
soil layer, vertical standpipe, actual native soil seepage rate, etc). The user can then calculate the
percent TSS reduction using a weighted average of the volume through the orifice, the volume infiltrated
and the volume that goes through the overflow structures. This is done using the detailed output from the
Biofilter Water Balance File. However, if the user chooses to do this, they need to double check that the
calculated infiltration rate through the soil for each event agrees with what they would think is

reasonable. To determine what the model calculated the infiltration rate through the engineered soil, you
take the Event Peak Outflow in cfs, divide it by the surface area of the biofilter, and then convert the units
from ft/sec to inches per hour. If the infiltration rate seems higher than what you believe is reasonable,
then the user needs to keep increasing the surface area until the calculated value seems reasonable.

The second way is to only model the very upper portion of the biofilter. So, if by design, your biofilter has
6 inches of open air depression, you would enter the Top Area as the top of your depression, the bottom
area would be the area at the bottom of your 6 inch depression. The depth would be 6 inches. The
depths of rock fill and engineer soil are zero. The Native Soil Seepage Rate because the engineered soll
infiltration rate. You enter your overflow structures — so if for example you have a vertical standpipe that
sticks up 3 inches into your depression, then its distance from the bottom would be .25 feet. The program
will then calculate the pollution reduction based on the amount of water that is infiltrated through the
engineered soil. You then need to multiply this percentage by the allowable percentage according to your
regulatory agency. For example, in the WDNR'’s 1004 code, it is 90%. This method obviously ignores the
infiltrate rate through the native soil. If you are in tight clays, chances are this assumption is okay. But if
you are in an area where you would see some infiltration into the native soil, this method may oversize
the biofilter.

In WinSLAMM version 9.3.0, and later, the algorithm was revised and biofilters should be modeled as
detailed in the construction plans.

Cost Data
Default Cost Information (February 2007)
Q. What are the costs for the BMPs based on?

A. The pre-determined cost data for all practices except catchbasin cleaning have been developed from
the SEWRPC (Southeastern Wisconsin Regional Planning Commission) Technical Report Number 31,
"Costs of Urban Nonpoint Surce Water Pollution Control Measures" (June 1991). These costs have been
updated to 2005 values by using the Engineering News Record cost indices. In addition, costs are also
available from many studies throughout the US and are adjusted by inflation indices for different areas
and times. Arvind Narayanan (a UA grad student) summarized this info in his master’s thesis, which is
the basis for the following report: Arvind and Pitt stormwater cost report

WinSLAMM vs WinDETPOND
WinSLAMM vs WinDETPOND (March 2008)

Q. Could you please give me a brief description of what WinDETPOND does that WinSLAMM does not
do?



A. WIinDETPOND is much more flexible when examining sedimentation processes (basically has more
data output options). In WinSLAMM, some of the details are not readily shown, which may be important
when evaluating a specific design. Both models examine detention the same way, but WinDETPOND
also considers short-circuiting (rarely very detrimental). Basically, WinDETPOND is our test bed and
many options start life there and are then installed in WinSLAMM later, after we work with it for awhile. If
you are doing R&D work, WinDETPOND will be important. WinSLAMM will help you evaluate how the unit
will function in a more complex area though.

Model Input and Output
Printing Model Input and Output (June 2013)
Q. Can | print the model input and output without doing screen captures?

A. Yes. To print the model input, select "File" > "Print Input Data". Select "Print Input to File", then
"Print". This will prompt a series of forms where you name the input file and select the location where it
will be saved. The print the model output, run the model. On the "Output Summary" form, below the
pollutant results grid, there are two options for printing. Select either option then follow the prompts to
name the output file and choose the location where it will be saved.

Outfall Total with Controls versus Annualized Total after Outfall Controls (November 2013)

Q. I am confused by a term on your Outfall Output Summary. Can you please explain the difference
between the two Yields listed: Outfall Total with Controls Vs. Annualized Total after Outfall Controls.

A. Outfall Total with Controls is the results for the model run for the rainfall file and rainfall dates you
chose.

Annualized Total after Outfall Controls takes the "Outfall Tota with Controls" and divides it by the "Years
in Model Run" to get an annual number. We added this feature when people starting running several
years of data - we wanted to make it so they didn't have to do the math if they wanted to see their
information on an annual basis.

If you chose a single year rainfall file, then you report the "Outfall Total with Controls" value.

Model Errors
User Mouse Use Speed (July 2013)

Q. | keep getting a model error when | am constructing or running model files. However, | cannot
duplicate the issue so that | can send the model file and description of steps to get the error to
PVA. What do | do?

A. Currently this is an issue with some users. One thought is that the user is moving through the
program faster than the program can write to the database. Try moving through the program slower than
you normally would. If this appears to solve the issue, please send PVA an email to let them know. PVA
is exploring options increase the speed the program writes to databases.

International Users (August 2013)

Q. My data entry appears to be correct. | get an error when | run the model.



A. ltis possible the error is due to some computer settings. The WinSLAMM program uses the format
"mm/dd/yy". If the computer settings are set to something different, the program cannot do its
calculations. To check this, go to "Control Panel: then "Date and Time", then "Change Date and Time",
then "Change Calendar Settings". Set thte data format to "m/d/yyyy".

Error Number 76, Path Not Found or Error Number 9, Subscript Out of Range (April 2013)

Q. I try to run my model file and | get Error Number 76, Path Not Found. | checked all my parameter files
paths and they are all referencing the correct location.

A. There are two possible reasons for this error. The first is that the parameter files are located in the
"X86" folder on your C:Drive. Windows will not allow the program to access files in this folder. To remedy
this, move the parameter files to another folder outside the "X86" folder. A "WinSLAMM Files" directory
with the parameter files is created in the root C:Drive and the default file paths reference this folder in an
attempt to avoid this issue. The section possible issue is that some of the *.CPZ - particle size distribution
- files are not referenced to the correct location. Check the particle size distribution file name and path in
both the control practices being modeled as well as in the "Tools" > "Program Options" > "Default Current
File Data".

Cannot see entire model screen (December 2012)

Q. lam using WinSLAMM v 10.0.0. When | attempt to model a biofilter, the screen does not complete
show up on my computer. The upper and left portion is unable to be accessed so that | can not save the
biofilter. See below for a copy of what my screen looks like. | can not drag the screen, etc. What do |
do?.

A. The issue is likely due to your monitor's screen resolution. Modify your monitor's screen resolution to
make the text size smaller. If the problem persists, contact PVA.
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